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Preface

This User Guide is been implemented by Boot & Work, Satarking
under the namelndustrial Shields.

Purpose of the manual

The hformation contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the following andie

Persons in charge of introducing automation devices.
Persons who design automation systems.

Persons who install or connect automation devices.
Persons who manage working automation installation.
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& Warnings:

1 Unused pins should not be connecteghdring the directive may damage the
controller.
1 Improper use of this product may severely damage the controller.
WSTSNJ (12 GKS O2yGNRffSNDRa ! aSNJ DdZARS NB3IAIF NR
{1 Before using this product, it is the responsibility of the user to i@dlS LINR RdzO(G Qa ! &
Guide and all accompanying documentation.
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Application Considerationsand Warranty

Read and Understand this Manu

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standardst hat apply to the combination of products
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

1 Systems, machines, and equipment that could present a risk to life or property.

T Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

9 Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customerdés request, | NDUSTRI AL SHI ELDS v
certification documents identifying ratings and limitations of use that apply to the

products. This information by itself is not sufficient for a complete determination of the

suitability of the products in combination with the system, machine, end product, or

other application or use.



Disclaimers

Weightsand Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in

determining suitability and does not constitute a warranty. It may represent the result of

| NDUSTRI AL SHI ELDS6s test conditions, and t he
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS

Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.

Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.



Warranty and Limitations of Liability

Warranty

I ndustri al Shieldsés exclusive warranty is that
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,

REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL

SHI ELDS6S ANALYSI S CONFI RMS THAT THE PRODUCTS \
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO

CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR

REPAIR.
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INDUSTRIAL SHIELDS

1 General Description Wi-Fi & Bluetooth CONTROLLER

1.1 Zone- Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the
shield from below and D the shield from above. The nhomenclature is represented on

the picture below:

{ i |

mn !
(HTT
HTTT

L]

A ZONE| mmmmizza |

o' A ZONE

1 The inputs in the zone B are named 10.X, being X any number suitable in the
Shield. Digital Outputs are named as Q0.X and Analog Outputs as A0.X.

1 The inputs in the zone C are named I1.X, being X any number suitable in the
Shield. Digital Outputs are named as Q1.X and Analog Outputs as Al1.X.

1 The inputs in the zone D are named 12.X, being X any number suitable in the
Shield. Digital Outputs are named as Q2.X and Analog Outputs as A2.X.



1.2 Zone Distribution

ZONEA |—>| ZONEB |— | ZONEC |— | ZONED

Communication

1.3 A Zone Features

— Analog — Analog —  Analog
L. Relay —  Relay L Relay
Shield A Zone

(1x) Ethernet

(1x) USB

(1x) 12C

(3x) TTL

(1X) RS-232

Communication | (1x) HALF/FULL Duplex RS-485

Shield

(1x) SPI external Port
(1x) RTC

(1x) uSD Socket

(1x) WiFi & BLE




1.4
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Mechanical dimension
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M-Duino3 BLOCKOs



1.5 GeneralFeatures

CONECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE

WiFi & BLE Controller General Spec.

Fuse protection (2.5A)

Input Voltage 12 to 24Vdc Polarity protection
| max. 1.5A
Size 101x119.5x94.7 101x119.5x119.3
Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader
SRAM 8KB
EEPROM 4KB

Communications

I2C i Ethernet Porti USBi WiFi &BLE T RS48571 RS232 -- SPI

1 (1x) Rx, Tx (Arduino pins)

Max232-Max485-W5500-ESP32

USB consideration!

Only meant for uploading or debugging, not always connected

as a serial in a project!

Cannot be working in a final
application

An/Dig Input 10bit
(0-10Vcce)

0 to 10V
Input Impedance: 39K
Separated PCB ground

Digital Isolated Input (24vcc)

7 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation

* Interrupt isolated Input HS
(24vcc)

7 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation

Analog Output 8bit
(0-10Vcce)

0 to 10Vdc
I max: 20 mA
Separated PCB ground

Digital Isolated Output (24Vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay

Imax 24Vdc: 410 mA

PWM lIsolated Output 8bit
(24Vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay

Expandability

12C - 127 elements - Serial Port RS232/RS485/WiFi/BLE

* By using this type of signal can no longer use Digital sighal (24Vdc)




2 Technical Specifications:

2.1 General Specifications:

Item

M-DUINO B ZONE

Power supply

voltage DC power supply

12 to 24Vvdc

Operating

voltage range DC power supply

11.4 to 25.4Vdc

Power
consumption DC power supply 30VAC max.
Power supply 24vdc
External voltage
power supply Power supply 700Ma

output capacity

Insulation resistance

20MY min.at 500Vdc between the AC terminal

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the
external AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 45°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 860g max.

2.2 Performance Specification:

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programmi ng | angu a g bttp:/afdsiro.ctieh/ButorialfHomePdue CoO .

Microcontroller

ATmega2560

Flash Memory

256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB
EEPROM 4KB

Clock Speed 16MHz

Clock Speed 16MHz



http://arduino.cc/en/Tutorial/HomePage

3 Precautions

Read this manual before attempting to use é&Fi & BLEPLCand follow its descriptios for
reference during operation.

3.1 Arduino Board

TheMDUINO PLERDUINO ETHERNET & WIFI &8lL8s ANALOG/DIGITRLUSricludes
anArduinoMegaBoard as controlleand a ESP32 Dev programmable chip as-&i\&iBLE
gateway

3.2 Intended Audience

This manuhis intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operat®i-Duinoaccording to the performance specifications described in this
manual.

Before using théiDUINO PLERDUINO ETHERNET & WIFIES81.Os ANALOG / DIGITAL
PLUSunder different conditions from what has been specified in this manual or integrating

into nuclear control systems, railroad systems, aviation systems, vehicles, combustion systems,
medical equipment, amusement machines,etgfequipment and other systems, machines,

and equipment that may have a serious influence on lives and property if used improperly,
consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance
characteristics othe Ethernet/WiHBLEControllerare sufficient for the systems, machines,

and equipment, and be sure to provide the systems, machines, and equipment double safety
mechanisms. This manual provides information for programming and operatingEhéNO
PLCARDUINO ETHERNEWK| & BLBE81/0Os ANALOG / DIGITRLUS

4 Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDEas it provides lots of libraries that helps in the programming.

Industrial Shields provides boards for programming the PLCs much easier. Basically it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up
automaticadly if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).



Steps:

1. Open Arduino IDEndgo to: &File-> Preferenceslocated in the top left corner.

Preferences X

Settings  Metworl:

Sketchbook: location:

C:\Users\Albert\Documents\Arduing Browse
Editor language: English (English) ~ | (requires restart of Arduino)

Editor font size: 15

Interface scale: Automatic | 100 5 [%  (requires restart of Arduino)

Show verbose output during: [ compilation upload
Compiler warnings: None

[CIpisplay line numbers

[C]Enable Code Folding

Verify code after upload

[[Juse external editor

Check: for updates on startup

Update sketch files to new extension on save (pde -> .ino)
Save when verifying or uploading

Additional Boards Manager URLs:  http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_inde: [
More preferences can be edited directly in the file
C:\Users\Albert\AppData\Local\Arduino15\preferences. et

(edit only when Arduino is not running)

Ok Cancel

2. In Additional BoardManagerURLs write the following:

http://apps.industrialshields.com/main/ardno/boards/package industrialshields index.json

3. Press OK to save the changes.

4. Goto: Toolsh . 2 I-NBdAardsXanager


http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

@ sketch_mar16a | Arduino 180

File Edit Skewh Tools Help

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Sertal Plotter

WFi101 Finmware Updater
Board: "M-Duino family”
Inchusirial Shaelcls: "M-Duino 58+
Port

Get Board Info

) Programmer: “Ardhino as ISP’
Burn Bootioader

- _
M

Baards Manager...
Arduino AVR Boards

Archuino Y

Arduino/Genin Uno

Arduino Duemilanove or Diecimila
Arduine Nano

Arduino/Gernuano Mega o Mega 2560
Arduin Mega ADK

Arduing Leonardo

Arduina Leonardo ETH
Arduino/Genwino Micro

Arduino Esplora

Arduino Mini

Arduina Ethernet

Arcuina Fio

Arduino BT

LilyPad Archuino USB

LilyPad Arduino

Arduine Pro of Pro Min

Arduing NG or older
Arduino Robot Control

Arduing Robot Motor

Arduino Gemma

Adatruit Cireuit Playground

Arduing Yuin Mini
Arduina Incustrial 101
Linina One

Arching Uno Wikl
Inchustiial Shields boards
Ardbox tamily

* M-Duino family

5. Search fodindustrialshields on the browse.

& Boards Manager

Type All ~ | |industrialshields

industrialshields

Boards included in this package:
ARDBOX family, M-Duino family.
Online help

More info

Install

Close

6. Click install (selecting the latest version).

Following thesesteps yu will be able tesee now the Industrial Shields Boards:




@ sketch mar16a | Arduing 180
file Eit Sketch Tools Help

Serial Monitor Ctrl oShifteld
Sertal Plotter Culsshiftel

Wi 101 Firm wase Updater

Boardt “Asduina Yiin' 3 Boards Manager.
Port chino AVR Boards
Get Board Info Arduing Yun
Archiino/ Gening Uno

Archino Duemilanove or Diecimila
Archino Nano

Arckano/Genuino Mega o Mega 2560

.

Program m er; “Arcuano as 158"

) Bum Bootioader

Ardhino Mega ADK
Arduino Leonardo
Ardino Leonardo ETH
Arduino/ Genuing Micro
Arciino Esplora

Ardhuino Mini

Arduino Ethemnet

Arcino Fia

Ardhuino BT

LilyPad Arduing USE:
LilyPad Arcuino

Ardhuino Pro of Pro Mini
Archiin NG or older
Ardino Robot Control
Arduino Robot Motor
Archino Gemma
Adalruit Circuit Playgroundd
Ardhiino Yun Mini
Arhino Industrial 101

- o *

Auta Format ClsT
Archive Sketch
sketch_mar1s  FixEncoding & Reload

Once it is selected the Ardbox Family oiDMino family an extra option will appear on Tools:

There, it can be selected the exact model for every family.

& Blink | Arduino 1.8.0
File Edit Sketch Tools Help
Auto Form at
Archive Sketch
Blink § Fix Encoding & Reload
Serial Monitor
Serial Plotter

WiFi1101 Firmware Updater

Board: "M-Duino family”

Industrial Shields: "M-Duino 19R+"
Port

Get Board Info

Programmer: "Arduino Gemma"
Burn Bootloader

M-Duino 19R
M-Duino 19R+
M-Duino 21
M-Duino 21+
M-Duino 38AR +
M-Duino 38R
M-Duino 38R+
M-Duino 42
M-Duino 42+
M-Duino 50RRA +
M-Duino 53ARR+
M-Duino 54ARA+
M-Duino 57 AAR+
M-Duino 57R
M-Duino 57R+
M-Duino 58
M-Duino 58+



Also there are some examples of pragiming in File> Examples> M-DuinoFamily.
Furthermore there are some extra ldres that can be found in Industrial Shields github.

https://github.com/IndustrialShields/



https://github.com/IndustrialShields/

5 How to connect PLC Arduino to PC

Connect USB port from PLC to PC.

NOTE:
M-DuinoFamily use USBB cable.

Open Arduino IDE interface:

Selectindustrial Shields bads ->M-DuinoFamily

Select the correc-DuinoBoard
M-Duino 58+

@ sketch_mar16a | Arduno 180 a  x
File et Sketch Tooks Help
[
Coteshiftsd
CuteshinteL
Boad by >
Incluswial Shields:“Arcbon Relay HF w) HIW RS- 232" 3 Abax Andlog
0 o | Ardbom Ansog HE
GetBowd Inlo Arcton Relay
§ . Ardbos Relay HF (legacy)
bbb fucane s 156 Ao Relay HE w/ HW RS-485
Bun Boattoater

& Archo Relday HF w/ HW RS-232

- Select correct port.

@ sketch mar16a | Arduino 130 - 8 x
File Eit Sketch Tools Help

ey se— e
Aschive Sketeh
e martf, e Encoding & Reload
Serial Monitor Corf+ShiftaM ~

T Potir Catestttal

VAR 101 Finmware Updater

Boaret "Arcbox lamily”
Industrial Shields: “Ardiox Analog™ >
Port §  senal port

7 GetBowdinfo COM13 {Ardhino Leonardo)

Programmer: “Archano as ISP
Bun Bootoader




6 How to connect PLC to power supply

- M-Duino FamilyPLCs are 124Vdc supplied. IMPORTANT: The pol&&tNOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the powesupply mains output is not higher than 24Vdc.

[romen v
u GND |

|—f 24Voo |

| I

- Suggested power suppliers

* Not recommended for industrial applicatioribhe =t
Jackconnectorneeds to be removednd use the live
and GND connectors. IL %



7 M-duino Family Pinout

7.1 A Zone connection

Base E
(common unit)
L] ]
A Zone
o § D% ] [

c . . . .
£9 I S = Configuration Switch{see sectior8 for
S = = & . . . .
ac 3 g saw configurng the communications

L = 10Ref . . . .
=0 < o S Enabling communications disables some
SCL 21 12C/SS o 1/Os)
SDA 20 12C/SS —
RX0 1 RX0/SS 504 ™
TXO 0 TX0/SS RX0
RX1 19 DONBT US il
X1 18 DONOT USE i1 ™
X 16 RX2(serial 2 RX s L . . .
RX 17 sz((serial 2)) e Communication P|n§e_r|al 1is used by
z- - RS485 v+ gz the ESP32 Wi & BLE integrated
Y+ - RS485 8
B- &
B- - RS485 A+ module)
A+ - RS485 2in 3
PIN3 | 3 Arduino Pin 2 e
50 SO 50 SPI 52 sck|”
518l 51 SPI Hesel
52 SCK 52 SPI Pin2
Reset | Reset SPI GND
vins | Vins 5v = s
PIN2 2 Arduino Pin oay g; Power supply connectors
GND - Gnd & (24Vdoc GND)
GND - Gnd —
24Vdc Power Supply l:é E_‘

SS: Chip Select pins. These pins can act as TTL, so they can work for the Chip Select pin of any device.

=

OFF ON
SCL/ 126
Base . SDA /125
(common unit) Rx1/116
Tx1/11.5
A Zone
PIN3/106
5 £ PiN2/105
o = a c D53(SD)
Q o
£ o c S FD re<es HD
5 £
A g _g 8 OFF ~ ON
! = 9]
=0 < [y -
AREF | AREF |Arduino PIN Q
IOREF2 | IOREF2 |Arduino PIN =
IOREF1 | IOREF1 |Arduino PIN W
7Vvdc 7Vdc - ©
GND GND GND =
3.3vdc | 3.3vdc |Arduino PIN -‘j
GND GND GND =
5vdc 5Vvdc - o
GND GND GND =
NC
NC
RTC SCL
RTC SDA




g

ETHERNET
placket
for internd access
e
lim.12/24Vdc
3ow

3
s B ¢
§ <€ Reser / UsBB “Frogram | £ l\s
F & 'RTCBanery (CB¥20) *uSD Socket[J
Ethernet Angino / Power
Connector Reset button
USB programmer Autoreset

connector

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using
serial communication. When uploading code to Arduino Mega set switch to ON.



7.2 B Zone (Analog Shield)
B Zone
oo £
2= o
5O 2 IS
s | 3 E
O < z
10.12 59 Analog/ Digital In
10.11 58 Analog/ Digital In
10.10 57 Analog/ Digital In
10.9 56 Analog/ Digital In
10.8 55} Analog/ Digital In
10.7 54 Analog/ Digital In
(-)10.6/INT1 8 GND 10.6
10.6/INT1 3 Interrupt 1 In
(-)10.5/INTO - GND 10.5
10.5/INTO* 2 Interrupt O In
(-)10.4 - GND 10.4
10.4 26 Digital Input
()03 - GND 10.3
10.3 25 Digital Input
(=)10.2 - GND 10.2
10.2 24 Digital Input
(=)10.1 - GND 10.1
10.1 23 Digital Input
(-)10.0 - GND 10.0
10.0 22 Digital Input
Top Zone

Led indicator I/Os state

B Zone
o =
c 9 £
5 9 o 8
ag o B
L c .E c
=5 5 5
O = T
<
GND GND GND
A0.7" 6 Analog Out
A0.6" 5 Analog Out
A0.5" 4 Analog Out
Q/vdc - External Isolated Out Vdc
COM(-) - External Isolated Out GND
Qo.7" 6 Digital/PWM Out
Q0.6" 5 Digital/PWM Out
Q0.5" 4 Digital/PWM Out
Q0.4 40 Digital Out
Q0.3 39 Digital Out
Q0.2 38 Digital Out
Q0.1 37 Digital Out
Q0. 36 Digital Out

—offfo—
Analog:
0-10vdc
Digital
5 - 24vde

E-l‘irth_a\t
5-24Vdc

(-) 1I06/ANT
10.6/INT 1<~
(-) I0.SANTDY
10.5/INT0=%

(104
04 o
() 10.3—
0.3 ot
() 10.2—
02 o
(101
0.1 o
() 10.0—
00

OFF: ANALOG

OM: DIGITAL

Ja
2 Analog:
0-10Vde
—Bigtar
Q/vde

C§ Digital/PWM

Q/vde

GND
AO.T

* Note: use correctly configuration for

use this signal
(see user guide)

Andog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

Configuration Switch*
(see section 8 to select the correct
configuration for outputs).

Analog Outputs

Voltage Supply/Referenctor
Digital/PWM Outputs (isolated)

PWM/Digital Outputs

! See sectiomB to select suitable switch configuration for enable these connections.



7.3

C Zone (Analog Shield)

C Zone
— c
o= o
S o o c —offj—
= c o AI:IT:;|OQI
Q& = © 0-10vde
el ° = Digital
(@] < I 5-24Vde
11.12 65 Analog/ Digital In Digital:
11.11 64 Analog/ Digital In B 24vde
11.10 63 Analog/ Digital In GND—|
11.9 62 Analog/ Digital In .12 _ofT%
11.8 61 Analog/ Digital In 1111 o
11.7 60 Analog/ Digital In i,
(-)I11.6/INT1 8 GND I11.6 B T
11.6/INT1" 19 Interrupt 1 In N7 —ofFx
()IL5/INTO - GND 1.5 e
11.5/INTO 18 Interrupt O In ) .5INTS,
(1.4 - GND 11.4 1 5/INTE
11.4 31 Digital Input
O3 ; GND I1.3 DaE
11.3 30 Digital Input () 11.3—
(.2 - GND I1.2 O
1.2 29 Digital Input M2 o
(1.1 - GND I11.1 ()11
L1 28 Digital Input 1o
(-)IL.0 - GND 11.0 1O o
11.0 27 Digital Input
Top Zone ]
Led indicator 1/Os state
C Zone 2887,
3%|at'e
EHEE
° 5 c
S5 | o § P,
Ag o = )
2. g < 8 —Dbigital
o _g L? Q/vde
O = ~Bgtarrwm
< Oﬁvdc
GND GND GND [GND |
ALT" 7 Analog Out N % o
Al6" 9 Analog Out e S |als)
A15" 8 Analog Out g
Q/vdc - External Isolated Out Vdc 5 Fgémﬁ
COM(-) - External Isolated Out GND H T T
Q17" 7 Digital/PWM Out - Qg
Q1.6 9 Digital/PWM Out T e
Q1.5 8 Digital/PWM Out 883 Q13
Q1.4 45 Digital Out £ SH
QL3 | 44 Digital Out 2% E Qo
Q1.2 43 Digital Out 238
Q1.1 42 Digital Out -
Q1. 41 Digital Out

Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

Configuration Switch*
(see section 8 to select the correct
configuraton for outputs).

Analog Outputs

Voltage Supply/Reference for
Digital/PWM Outputs (isolated)

PWM/Digital Outputs

See sectio to select suitable switchonfiguratbn for enable these connections



7.4 D Zone(Analog Shield)
D Zone
— c ]
°2 o
€ o o c —(De
S g k= o Analog”
Qc =) 3] 0-10vde
S o ° c Digital
(@] < I 5-24vde
oo
12.12 NC NC Digital:
12.11 NC NC 5-24vae
12.10 69 Analog/ Digital In
12.9 68 Analog/ Digital In
12.8 67 Analog/ Digital In
12.7 66 Analog/ Digital In
(-)12.6/INT1 - GND 12.6
12.6/INT1* 21 Interrupt 1 In i
(-)12.5/INTO - GND 12.5 () 2.BANT2H
12.5/INTO* 20 Interrupt O In 12.6/INT2.
(-)12.4 NC NC ()12 SNT3
oy NG NG 12.5/INT2
O2.3 - GND 12.3 () 12.4—
12.3 35 Digital Input 124 o
(2.2 - GND 2.2 Q23—
12.2 34 Digital Input G2
O2.1 - GND 12.1 122 o
12.1 33 Digital Input () 21—
(O)12.0 . GND 12.0 '(?)-]2 s
12.0 32 Digital Input 120 -0
Top zone —
O |mogFem oam Digan In intn
O C|O OO © © OloJo
8 8 8~ 2 3 &8 2R
Led indicator I/Os state
_z[Ne
D Zone 53|27
a*la26
z%|Q25
o — 4 Analog
g % DE_ 8 amlvgc
[a) g o 8 ~®_IZJig\taI:
2‘ c % % Qrvde
8 B L QY ravewm:
< Qi vde
GND | GND GND Co |2
A27 NC - 5 HE- |26
A2.6! 13 Analog Out 5 ~3- (A28
A25" 12 Analog Out 2 L arvde
Q/vdc = External Isolated Out Vdc 2 — com(-)
COM() - External Isolated Out GND g BNy
Q2.7 NC - = r&mas
1 - £ H&M Q2.5
Q2.6 13 Digital/PWM Out 8 - |l oo
Q25" 12 Digital/PWM Out 382 %L @23
Q2.4 NC - 832 ~
Q2.3 49 Digital Out s2% 83
Q2.2 48 Digital Out H 2 8 b ’
Q2.1 47 Digital Out - ]
Q2. 53 Digital Out

Analog/Digital Inputs

Interrupt Inputs (isolated)

Digital Inputs (isolated)

Configuration Switch*
(see section 8 to select the correct
configuration for outputs).

Analog Outputs

Voltage Supply/Reference for
Digital/PWM Outputs (isolated)

PWM/Digital Outputs

See section 8 to select suitable switch configamafior enable these connections.



8 Switch Configuration

8.1 A Zone:Communications

LEFT ZONE
Switch Analog Shield
ON OFF
D ZONE
SCL/12.6 12.6 SCL
SDA/I2.5 12.5 SDA
C ZONE
RX1/11.6 11.6 RX1
TX1/11.5 11.5 TX1
B ZONE
Pin 3/10.6 10.6 Pin 3
Pin 2/10.5 10.5 Pin 2
uSD & R885
D53(SD) Q2.0 SD
FD R&185 HD HD FD
OFF ON
SCL/12.6
SDA/12.5
Rx1/11.6
™xX1/11.5
Pin3/10.6
Pin2 /10.5
D53(SD)
FD RS485 HD
OFF ON

4. SCL/12.6Choosing between SCL or the input 12.6. If this switch is ON, it enables the 12.6
input and disables the SCL. If this switch is OFF, it enables SCL and disables 12.6. If it is a Relay

Shield 12.6 is changddr 12.1

3. SDA/I2.5:Choosing between SDA or the input 12.5. If this switch is ON, it enables the 12.5
input and disables the SDA. If this switch is OFF, it enables SDA and disables 12.5. If it is a Relay
Shield 12.5 is changed for 12.0.

2. RX1/11.6Choosing between RX1 or the input I1.6. If this switch is ON, it enables the 11.6
input and disables the RX1. If this switch is OFF, it enables RX1 and disables I1.6.

1. TX1/11.5:Choosing between TX1 or the input I11.5. If this switch is ON, it erthieldé$.5
input and disables the TX1. If this switch is OFF, it enables TX1 and disables 11.5



4.Pin3/10.6: ChoosingetweenPin3 or the input 10.6. If this switch is ON, it enablesthe 10.6
input anddisableghe Pin3. If this switchis OFFjt enablesPin3 anddisabled0.6.

3. Pin2/10.5: ChoosingbetweenPin2 or the input 10.5.1f this switchis ON,it enablesthe 10.5
input anddisableghe Pin2. If this switchis OFFjt enablesPin3 anddisabled0.5.

2.D53(SD):If this Switch is OFE,enables the Chip Select of the microSD socket and disables
Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the microSD
OFyQili o6S dzaSR®

*If the D Zone is an Analog Shield, Q2.0 is also related with D53. Beitig OEB®lode the SD cardMUST NOT be

used because it can corrupt the micraSD

1. FDRS485HD: ChoosingetweenFDor HF.If this switchis ON, it enablesthe HalfDuplex
(HD)option anddisableshe FD.If this switchis OFFjt enablesFullDuplex(FD)anddisables
HD.

LEFT ZONE ore =
SWITCH ON OFF
NC - -
NC - ; RTC SCL

RTC SCL RTC - ITC}EL

RTC SDA RTC - s

1. RTC SDAhis switch enables the communication to communicate with the RTC
using 12C. Having this switch in ON mode it actives this communication,
whereas if it is IOFF mode it disables the 12C to reach the RTC.

2. RTC SCrIhis switch enables the communication to communicate with the RTC
using 12C. Having this switch in ON mode it actives this communication,
whereas if it is in OFF mode it disables the 12C to reaesRil C.

A 2 4 ooaA

3.NCb2i O2yySOiGSR® ¢KAa agA00OK Aa yz2ia 0O2yy

A 2 4 ooaA

4. NCbh2(i O2yySOGSR® ¢KA&A asAlO0OK Aa y2i 0O2yy
if it is in ON mode or OFF mode.



8.2 B Zone:AnalogShidd

B ZONE C ZONE D ZONE
SWITCH[ ON | OFF SWITCH| ON | OFF SWITCH| ON | OFF
NC - - NC - - NC - -
Q0.7 | Q0.7| A0.7 QL7 |QL7|AL7 Q2.7 - -
Q0.6 | Q0.6| AD.6 Q16 |Ql6|AL6 Q2.6 | Q2.6|A26
Q05 | Q0.5|A0.5 Ql5 |Ql5|Al5 Q25 |Q25|A25

g|INC
gg gg Q17
g§ 521Q16
2k 55|Q15

For theAnalogShield(Zone B & Zone @)a switch is set to ON, it can only act as Digital
Output. If it is set to OFF it can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with @X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented witl0A, being X any number of the tables abo

9 1/Os 5V pins

TheMDUINO PLC ARDUINO ETHERNET & WIFb&IBEANALOG/DIGITRLUSas some

of the Mega board pins available. édepins can be programmed according to Arduino
features such as I/Os operating at 5V or any additional featuregptas the pins (for

example 12C communication in pins SCL and $BAhis pins are directly connected to the
Arduino Mega board they are not as well protect as the normal inputs. These pins are mainly
meant to be used as prototyping.

The Arduino boardwailable pins are summarized in the table below. lteorto access some
of thesepins the configuration switch must be set to OFF position (see se®jtemd some
extra considerations must be taken in consideration when using these pins

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0




TXO0 1
RX1 19 DONOT USE!
TX1 18 DONO6T USE!
MISO 50
MOSI 51
SCK 52
Pin 3 3 Communication switch: OFF
Pin 2 2 Communication switch: OFF

*IMPORTANTDo not connect the terminals in the chart above to voltages higher than 5V.
These terminals provide direct access to the Mega board.

A part from the switch configuration there are some special conditions depending on these 5V.
Now it is going tde shown the considerations to operate with these pins.

In the WiFi & BLE Controller, Serial 1(Tx1 & Rx1) is used to communicate through the ESP32
integrated in theMDUINO PLC ARDUINO ETHERNET & WIFb&IBREANALOG/DIGITAL
PLUS.

9.1 12C pinsz SDA/SCL

The 12C protocol is meant to work in a puil configuration. A pulip configuration means
that when the pin is at rest (nothing connected to it) it always remH$GH value. In this case
it reads 5V when nothing is connected. The qpipliconfigurationis stablished by default in
these pins.

If it is meant to work them as a GPAOBV, it has to be considered that they are pulb
inputs.

*IMPORTANT: 12.5 & 12.6 are not puyl inputs although they are referred to the 12C pins
(switch configuration). Tére isk & NJp@lapNdclitcthat is stablished in order to have the
same behaviour as the other inputs.

9.2 Serial 0z RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins arér@ady performing a function. This is because they are shared
with the USB interface. If using these pins, the USB communication cannot be working at the
same time. When the PLC is not installed, the USB communication is normally required for
debugging, uading and intercommunicating with tHethernet controller If using both
interfaces athe same time theArduino boardwill get blocked.

These pins are not stablished with a pytl or a puldown configuration. The state of these
pins isunknown. If tlese pins must be used, they require a puplor a pulldown
configuration. The Arduino board allows the pins to be set in ayputionfiguration. If not it
must be stablished an external pulp or pultidown circuit in order to correctly work with
thesepins.

9.3 Serial 17 RX1/TX1



In the WiFi & BLEontroller, Serial 1 is used to communicate throughE$#®P3tegratedin
the MDUINO PLC ARDUINO ETHERNET & WIFS&IBEANALOG/DIGITRLUS

5hbQ¢ | {9 {9wL![ ™

9.4 SPIz MISO/MOSI/SCK

These pins can only woas a 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not stablished walpultup or a puldown configuration. The state of these
pins is unknown. If these pins must be used, they require aupudir a puldown
configuration. The Arduino board allows the pins to be set in aygudonfiguration. If not it
must be stablisbd an external pulip or pultdown circuit in order to correctly work with
these pins.

95 Pin 2/Pin 3

These pins are only referred to the inputs 10.5/10.6. If the switch configuration is in OFF
position thepinsPin 2/Pin 3 will be available.

These pins araot stablished with a puilip or a puldown configuration. The state of these
pins is unknown. If these pins must be used, they require aupudlr a puldown
configuration. The Arduino board allows the pins to be set in ayputionfiguration. If noit
must be stablished an external pulp or pultidown circuit in order to correctly work with
these pins.



10 A Zone Features: Communications & RTC & uSD

10.1 RS232

The Arduino Mega function code to access the2B&Eport in the MDuino is Serial2 (pinl6
and 17 of the Arduino Mega).

FortheRSHoH O2YYdzyAOF A2y LINRP(G202f (GKSNB AayQi
matter the configuration of the switches to implement a-B& communication.

Using the boards of Industrial Shields, there library that simplifies the R&32
implementation.

10.2 RS485

For RS485 communication protocol the defined Arduino Mega pins are showed in the chart
below.

Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the R85 communicationprotocol there is ofy one switch that affects in this
communication. The R&5 protocol will be always enabled, the only switch that affects is the
2yS OFIft@i8R &63 KA. J8s syitthOnakeLtlye choosing betweerdRS

Half Duplex or R&35 Full Duplex (R&2).

Using the boards of Industrial Shields, there is a library that diegpthe R85
implementation.

10.3 I12C

I2C communicatioDOES NOT REQUERrRRUIFUp resistorfor the M-Duino FamilyThe puHlup
resistor is already implemented in the PCB.

I2C communication is configured by switches, so the switches must be configured in order to
enable the 12C communication.

To enable 12C the switches SCL/I12.6(12.1) & SDA/I2.5(12.0) must be set to OFF mode. In this
mode the inputs are totally disabled and the&Cl%s now enabled.



Industrial Shields does not provide any library to implement the 12C as it can be used the
standard library of Arduino called Wire.

10.4 SPI

The MDuino pins used for the SPI bus are summarized in the table below. For SPI bus MISO,
MOSI and BOCK pins are common to all the connected devices to trilMo, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 SO 50
MOSI 51 SI 51
CLOCK 52 SCK 52
Reset Reset Re®t
SS SCL/SDA/RXO/TXO/RX1/TX1/RX3/TX3/Pin2/P| 21/20/1/0/19/18/15/14/2/3

Check the witch configuration at section ® enable SS pins.

10.5 TTL

M-Duino hasone TTLport, RXO/TXORX1/TX1s used for WFi and BLE communicatipd TLO
is accessed with thaihction Serial (pins 0 and 1 of the Arduino Mega).

10.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the compatible IC compatible
with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino ldésare compatible

with the M-Duino. In the MDuino, W5500 IC communicates to the Mega boaadSRI bus (SS
Arduino Mega pin 10

10.7 RTC

M-Duino RTC Module is based on th§1307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the [26quol.

4 switches have to be configured in order to enable the RTC features:

LEFT ZONE
SWITCH | ON OFF | RTC SCL & RTC SDA must be set to ON mode to enable

sg - - the 12C wires to the RTC. If they are in OFF mode, th
RTCSCL | RTC | ' N\RdzAy2 42yQd O2YYdzy/AOFUS
RTCSDA | RTC :

g AGK



Switch Analog Shield
ON OFF | 12C must be enabled in order to commuatie with the
SCL/I12.6 2.6 SCL RTC. See section I2C to enable it.
SDA/I2.5 12.5 SDA

Using the boards of Industrial Shields, there libr@ary that simplifies thdRTC implementation
called RTC.

10.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switctiest configure it.However there is a switch that
must ke placed to ON mode in order to communicate with the uSD:

D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket and disables
Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the microSD
Ol y Quéed.o S

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal partthadocket is located
under the supply of the Arduino.

Switch Analog Shield
ON OFF
D53(SD) Q2.0 | D53(SD)

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SDIt is the same as the Arduino library, with the only modification of using the pin 53 to
selectthe Chip Select dhe uSD chip.



10.9 WiFi & BLE

The WiFiand Bluetooth integrated module consistsin a single 2.4 GHzWi-Fi and Bluetooth
combo chip designedwith the TSMCultra-low-power 40 nm technology.lt is designedto
achievethe best power and RFperformance showingrobustnessyersatilityandreliability in a
wide variety of applicationsand power scenarios.Someapplicationsare GenericLowpower
loT SensoHub,GenericLow-power loT DataLoggersaand MeshNetwork.

It isdesignedor Internet-of-Things(loT)applications.

10.9.1 GeneralSpecifications

Wi-Fi

1 802.11b/g/n

7 802.11n(2.4GHz)upto 150Mbps
Bluetooth

1 Bluetooth4.2 BR/EDMBLEdualmodecontroller
1 +12dBmtransmittingpower
1 NZIFeceiverwith -97 dBmBLEsensitivity

10.9.2 WiFi & Bluetooth Module Configuation

In orderto configurethe WiFi& BLEModule,you mustconnectit to aPC.
Toconnectit youwill needamicroUSBo USBcable.

Theslot for the micro USBnput is locatedon the right sideof your equipment.

Toloadthe programinto the ESP3%ou haveto installthe boardon the ArduinolDEsoftware
Goto File> Preferencesndinto AdditionalBoardsManagerURLsddthe next

URL https://dl.espressif.com/dl/package esp32 ixlgson

*If you already have one URL put it next to the other separetedanya, like in the image
below.


https://dl.espressif.com/dl/package_esp32_index.json

Preferences

X
Settngs  Network
Sketchbook location:
C:\UsersUSER \Documents \Arduino Browse
Editor language: Engiish (Englsh) «  (requres restart of Arduino)
Editor font size: 13
Interface scale: M Automatic 100 T % (requires restart of Arduino)
Theme:

Default theme | (requires restart of Arduino)
Show verbose output during: [ | compilation [ upload
Compler warnings: None

[[] Osplay ine numbers

[JEnable Code Folding

[A verify code after upload

] Use external editor

[ Aggressively cache complled core

A Check for updates on startup

[ Update sketch files to new extension on save (.pde -> .ino)
4 Save when verifying or uploadng

Additional Boards Manager URLs: | o/boards/package _industriaishields_index.json, [Tt e pes e

ore preferences can be edited dreclly in the fie

C:\Users \USER \AppData Local\Arduino 1 5\preferences. txt

edt only when Aduro 5 rune

Nowyouare ableto installthe board.Goto Tools> Boards> BoardsManagerand searchby
ESP32.

Will appearthe esp32by EspressiSystemsindall it.

Onceit isinstalledgoto Tools>Boardsand chooseESP3DevModule



& sketch_may17a | Arduino 1.8.0
File Edit Sketch Tools Help

Auto Form at Cirl+T
Archive Sketch
sketch_may17] Fix Encoding & Reload
. Serial Monitor Cirl+Shift+M
vold setup i .
Serial Plotter Crl +Shift+L
/7 oput v
WiFi101 Firmware Updater
' Board: "ESP32 Dev Module" 3 _ . A
Flash Mode: "QIO" 3 LilyPad Arduino
void loop( Flash Frequency: "80MHz" | Arduino Pro or Pro Mini
/7 PUt ¥ cpy Frequency: "240MHz (WiFi/BT)" s Arduino NG or older
Flash Size: "4MB (32Mb)" 3 Arduino Robot Control
t PSRAM: "Disabled” 3 Arduino Robot Motor
Partition Scheme: "Default 4MB with spiffs (1.2MB APP/1.5MB SPIFFS)" g CENEDEEnG
Upload Speed: "921600" 3 Adafruit Circuit Playground
Core Debug Level: "None" 3 Arduino Yin Mini
Port Arduino Industrial 101
Get Board Info Linino One
Arduino Uno WiFi
Programm er: "Arduino Gemma" 3 ESP32 Arduino
Burn Bootioader ® ESP32 Dev Module
ESP32 Wrover Module
ESP32 Pico Kit

Turta loT Node

TTGO LoRa32-OLED V1

XinaBox CW02

SparkFun ESP32 Thing

u-blox NINA-W10 series (ESP32)
Widora AIR

Electronic SweetPeas - ESP320

Theinternal connections between thESP32nodule and theArduino Mega are the following:

Arduino Mega Pinout ESP32 Pinout
5Vdc Vcce
GND GND
Tx1 (Pin 18) TxD
Rx1 (Pin19) RxD

WiFi and Bluetooth aralways enabled as there are no switches that configure it.
The WiFi and Bluetooth module ussriall for communication

More information: https://www.industrialshields.com/blog/industriathieldsblog-1/post/wifi-
bluetooth-module-esp32devkitv1-133



https://www.industrialshields.com/blog/industrial-shields-blog-1/post/wifi-bluetooth-module-esp32-devkit-v1-133
https://www.industrialshields.com/blog/industrial-shields-blog-1/post/wifi-bluetooth-module-esp32-devkit-v1-133

11 I/O technical details:

Digital Output Waveform:

[N o e——
v

DIGITALOUT

CH1 ¥ Z88m

DIGITAL OUT




Analog Out Turn On:

]

ANALOGOUT

ANALDG OUT




12 Typical Connections

DIGITAL ISOLATED INPUT

E GND (-)10.0
512124V 10.0

GND
@ POWER
12/24v B oemaw

Download the MDUINOG LAYOUT:
From: www.industrialshields.com

DIGITAL NO-ISOLATED INPUT

(-) 10.0
o——— 00

ET‘GND POWER

12/24v [ DIGITALIN

Download the MDUINOG LAYOUT:
From: www.industrialahiolds.com

DIGITAL/ANALOG INPUT
(Digital)

D Y 4

GND
@ POWER
12124V B owmauanaoc v

Downioad the MDUING LAYOUT:
i From: www.industrialshields.com
















